	wrong
	0
	1
	2
	3
	4
	5
	6
	7
	8
	9
	10
	11
	12
	13
	14
	15
	16
	17
	

	right
	24
	23
	22
	21
	20
	19
	18
	17
	16
	15
	14
	13
	12
	11
	10
	9
	8
	7
	

	score
	100
	95.8
	91.7
	87.5
	83.3
	79.2
	75.0
	70.8
	66.7
	62.5
	58.3
	54.2
	50.0
	45.8
	41.7
	37.5
	33.3
	29.2
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Figuring Biological Data	 Name	
Last week you collected data and contributed to two databases. One dataset showing measurements of soaked and dry beans is found on pages 4 and 5 of your Biologist At Work worksheet. The other dataset contains body measurements of the students in our course and is provided as an Excel™ spreadsheet found on our course website (plantphys.info). Today we will learn how to show the results of our studies in the form of tables and figures of publishable quality. This goal is one of the critical skills for a biologist and thus is an important part of this course. Part of your preparation for today's work is reading pages 163-186 in our Pechenik text.
The basic features of professional figures are simplicity, boldness, and legibility. Word™ and Excel™ are able to produce professional figures, but are not designed to do so by default. The “stock” graphics made by this software need considerable alteration to be acceptable by your biology teachers in all future courses. Learning how to eliminate the “fluff” and “fancy” trash from the default tables and graphs and enhancing their simplicity, boldness, and legibility are critical to your future success in laboratory report writing. This part of the task is fairly simple and you should be able to do it by the end of this writing project.
An even more important part of learning how to make high-quality graphics is to know which kind of graphic shows your data to best advantage. This skill comes with experience, as you might guess and has a subjective quality to it. While we will learn how to nicely show comparative data and relationships in our two datasets from last week, data in future comparative studies may be more challenging in this regard. So starting to gain the needed experience for making such judgments and choices will develop over your career as a biologist at ECSU. You will not have complete command of this skill within the limitations of this one exercise.
Presenting Data in a Table.
Tables are most appropriate when at least one of the variables in the experiment is categorical (has discrete states) rather than continuous (has a spectrum of states). For complex datasets with many states of a categorical variable, or datasets in which both dependent and independent variables are continuous, a table is probably a poor way to communicate the data. But there are many perspectives on that.
Statistical Transformation.
Last week you were attempting to answer the question of whether there was any difference between the left and right hands in our section dataset from the screen. Repeat your statistical test, but this time use the larger dataset of this entire course (downloaded from the course website) and put the results in this table: (hint: round off properly and use leading 0’s.)
	
	Left hands in course:
	Right hands in course:

	Mean width (cm)
	.
	.

	Standard Deviation (cm)
	.
	.

	Student’s t-test value of p
	.     
	same     different
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Statistical transformation of the data allows many cells to be reduced to just a few items of data that can be presented in a table. This kind of transformation allows you to show a colleague the results of your experiment in a compact space allowing direct comparison of the outcomes along with an indication of how meaningful the differences are. This kind of table is much more effective in communicating with your audience than a chart of raw data. Unless an instructor specifically asks for raw data, some kind of statistical transformation is usually expected.

In this case we are comparing two conditions of a categorical variable (left vs right hand) we have chosen (independent variable) to compare. The hand width is the continuous variable we measured (the dependent variable). The dependent (measured) variable is represented in the body cells of the table. The independent variable (chosen or manipulated) is represented in the row (sometimes column) headers. A table allows the reader to directly compare the left and right widths without looking at the dozens of cells (approaching 100 for our class!) of raw measurements. The inclusion of the value of p from Student’s (1908) t-test allows the reader to determine whether the difference is meaningful or not. In this table you want to observe proper rounding of numbers. In general p is traditionally shown rounded to three decimal places. You can probably guess why (hint: what is the typical -value to which the p-value is compared?).

Nonstatistical Transformation of Data.
Back in the Excel™ dataset file, select the Dom=L/R column, and insert two new columns to the right of the “Right hand (cm)” width column. Label one new column header “Dominant” and the other new column header “Antidominant.” In each row of the new columns, copy the data from the “Left” or “Right” columns of that row as they correspond to the “Dominant” and “Antidominant” hand using the “Dom=L/R” column as the organizing fact. Hint: since most are right hand dominant, maybe starting with a copy of that column under dominant and then correcting it for the left-handed folk is an easier way than typing all the data with inherent possible human errors?!

Repeat the statistical transformation process with the course data now represented in the two new columns and enter the results in this table: (Rounding? Leading 0?)
	
	Dominant hands:
	Antidominant hands:

	Mean width (cm)
	.
	.

	Standard Deviation (cm)
	.
	.

	Student’s t-test value of p
	.     
	same     different



Items to Think About
What was the purpose of doing all this non-statistical transformation of the dataset? Obviously we are trying to answer a different question based upon a different observation. Have you ever observed the hands and arms of someone who does heavy labor with just one of their hands (e.g. a roofing shingler, a tennis pro, a carpenter, etc.)? In these cases the dominant hand bulks up because of the extra exercise it gets. Do our data show this kind of differential mass? If not, why not? Why do you think there is so little difference between the means and standard deviations between the two ways of looking at the data?
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The tables we have produced are not in professional form. They need to be simplified. Because they are so similar, they can probably be combined. The combined table needs an explanatory Table heading. Data in a table cell are often represented as mean  standard deviation. While the p-value is important, the decision (same-different) could be left to the reader (based in part on her/his choice of -value to compare with the p-value shown). This kind of reorganization of the tables above could reduce them to an even more compact size.

Table 1. Making Your First Table for Presentation
Tables can be easily prepared in Microsoft Word™. What you will hand in for this week’s work is a printout from a single Word™ document with all of the properly formatted tables and figures. Open a blank document in Word™. Type your name and hit return; align this paragraph to the right.

Type a suitable table caption in the word processor; this paragraph starts with the word “Table” followed by a number (sequential starting with 1.), and a title for the table with capital-letter suppression (i.e. sentence case). Subsequent sentences in the caption should indicate what was measured and how, or any conditions, including the kind of statistical test (# tails, paired?, Student’s?) that produced the value of p. The caption text should not reiterate or interpret the data; nor should it discuss the data; it simply makes the table stand on its own in terms of being understood by the reader. It answers these basic questions: What is this graphic showing? How were the data obtained? How were the data analyzed? After typing the caption, hit return; the table goes under this caption.

Select Table-Insert-Table… This brings up a table tab in the ribbon. Click on the New button and drag the number of columns and rows. Be sure to allow a row for column headers and a column for row headers (we need 3 columns and 5 rows). In most cases, the first cell in the top row will be left blank. In this case, the second cell will be marked “Mean Width ± SD (cm),” and the third cell will be marked “p.” The first cell in the second row will be marked “Left Hand” while the first cell in the third row will be marked “Right Hand.” Continue in the fourth and fifth rows with “Dominant Hand” and “Antidominant Hand.” Note: the ± symbol is typed by option-shift =  (or alt-shift =).

Select the Tables tab in the ribbon if it is not already selected. Select all of the cells in the table including all header cells. Click the Borders button and select the None icon in the popup. The table cell borders will become invisible. Select just the data cells in the table (exclude the headers). Again click the Borders button and select the All icon in the popup. Each data cell should now have top, bottom, left, and right borders. After filling the table with the statistical data, align the text in the cells in a uniform and clear way. With one or more table cells selected, select the Table Layout tab in the ribbon, click on the Align button and select the appropriate alignment. For data cells, centered (horizontally and vertically) is usually appropriate. For column headers, bottom centered is the better choice. For row headers, centered right is the better choice. You can adjust the column widths (select all rows, drag blue waffles in the ruler) and font sizes (Home tab) so that the information fills the cell spaces more fully. Bold and/or large and legible is important. Use a serif font (Times); avoid fancy fonts, shading, or other “cool” choices that distract the reader from the data. You might want to merge some (which?) of the cells (select cells, click Merge button in Table Layout ribbon).

You should format the caption with a hanging indent (=outdent). This is most easily done with the ruler, but can also be done under the menubar Format—Paragraph—Indentation—Special—Hanging choice.

One other trick I will suggest you learn is how to force a page break to put a second table on a separate page in the same Word™ file. Rather than hitting return many times to get a new page, instead select menubar Insert-Break-PageBreak. This will put you at the beginning of a new page.

 (
Ã
)Produce a proper Table 1 as described above on a single page of the file. Be sure it has the caption above the table. Be sure your name is clearly shown above the caption. While you may help and constructively critique each other, you must do your own personal data transformations, must write your own captions, and must prepare your own graphics. Partners simply printing copies of the same Word™ file is strictly prohibited! You need to learn how to do all of this ON YOUR OWN!

Table 2: Further Transforming and Sorting a Dataset for a Second Table.
Gender (Sex=M/F) is also a categorical variable. How would our Excel™ data need to be reorganized to show whether males had a greater hand-width disparity than females in a table?

Insert a new column to the right of the “Antidominant” column. In the top cell type “Disparity.” In the second cell of the new column type the formula: “=abs(” then click on the dominant hand width in that row. Continue the formula by typing “-” and then click on the antidominant hand width in that row. Type “)” to end the formula and then hit return. Click on the cell with the new formula result. Select Edit-Copy. Click-drag from the cell below this one to the last cell in the new column. Select Edit-Paste. You should now have a new column representing the difference in hand widths. The formula component “abs” takes the absolute value of the difference, so all values in the column are positive in sign.

At the far left of the spreadsheet, drag from the row header “2” through “__” to select all the rows of the raw data in the sheet (this should exclude the row of column headers across the top of the columns and also any rows of statistical formulas at the bottom of the data columns). Select Data-Sort… In the dialog box, change the “Sort By” entry to “Sex=M/F” and hit return. The datasheet should now be sorted with rows for data from female bodies at the top, and rows for data from male bodies toward the bottom.

At the bottom of the “Disparity” column, type in a formula to show the mean and standard deviation for females in a single cell. Here is an example of a formula that would work. To enter the “” character, on Mac hit option-shift +, on a PC  hit alt-shift +. It will look better if you put a space before and after it in the formula as shown here:

=ROUND(AVERAGE(E2:E__),2) & " ± " & ROUND(STDEV(E2:E__),2)

In this formula, the “Round” command will show 2 decimal places for the nested average formula. The “&” entry will follow the first calculated value in the cell by something else. The “” separators encircle some text to be next. After another “&” concatenator is the rounded standard deviation formula. The blanks are for the largest row number for females in the data.

In the cell below this, paste the same formula…then alter it for the male bodies in the class.

In the cell below that, enter your t-test formula at the bottom of the “Disparity” column, remembering that the two arrays of data are both in portions of the one column and the data are not paired…and modifying the formula accordingly. Set the number format to 3 decimal places.

Produce a proper Table 2 comparing male and female hand width disparity data, using the instructions above with necessary modifications for this comparison. This can be entered into the second page of your Word™ file of tables. An Edit-Copy and Edit-Paste Special-Unformatted of Table 1 (and its caption!) for modification might speed and ease your work. Note: deleting selected rows of a table is not accomplished by Edit-Delete; instead use Tables>Table Layout-Rows & Columns-Delete Row icon.

Charting Human Measures Data:
The Excel™ dataset has two columns of data remaining: Body Height (m) and Body Weight (kg). These variables are continuous just as the hand widths are continuous. There is continuous variation between the extremes of minimum and maximum values measured. If we wanted to answer if taller or heavier people had wider dominant hands or more disparity between their hands, or if taller bodies were heavier, we would be dealing with two continuous variables in the comparisons we want to make. For comparing two continuous variables, a table is probably not going to be very helpful in visualizing the relationships. A Figure (aka an Excel™ Chart) is likely a much better choice.

Figure 1. Is there a correlation between left and right hand widths?
Select the data (A2:B__), then choose Insert-Chart, in the menubar select Insert-Chart, click the Other button and scroll to Scatter (NOT Line!), select the Marked Scatter icon without lines. Click on the Chart Layout Tab. Click the Chart Title button and select No Chart Title. Click on the Axis Titles button and select Horizontal and Below Axis in the popup. Type a title and be sure your axis titles have units (cm). How do you know if you have your axis labels correct? Change a left hand data point in the spreadsheet by reversing the digits (e.g. 8.5 to 5.8) and then decide from the new point if you have right and left reversed. Don’t forget to restore the altered number to its full accuracy. Click on the Axis Titles button and select Vertical and Rotated in the popup. Type the title and its units. Click on the Legend button and select No legend in the popup. Click on the Gridlines button and select No Gridlines for both axes.

Click on the Home tab and set the font for the graph to Arial and 12 point. Select each axis title and increase the font to 14 point bold. With no title selected (but the chart selected) click on the Charts>Format tab; click the Line button and select No Line in the popup. 

Select the Plot-Area and on the Charts>Format tab set a Line Color to Black, Line Weight to 3 pt, and Fill Color to No Fill. Select each axis (click on the numbers) and on the Charts>Format tab, set the Line Color to Black, Weight to 3 pt, and Fill Color to No Fill. Your axis lines and tick marks should now match the plot area border…nice and bold!

Double-click (Right-click) each axis to Format the axis. Set each axis Scale Minimum and Maximum to eliminate wasted space and to get nice round numbers on the scale. You need your scales to have between 4 and 8 tick marks only; if needed, this is achieved by adjusting the major unit (in this case to 1)! Set each axis Number to no decimals (you have to first unclick “Linked to source” to then set the Decimal places: to 0. Your symbols should now be spread across the graph in both dimensions and the axis scales are bold and simple!

Double-click (Right-click) the symbols to Format Data Series. Set the Marker Style to one of the standards: Square, Circle, or Triangle (the diamond is NOT a standard marker!). Set the Marker Line Color to White and its Weight to 1.5pt. Set the Marker Fill Color to Black. Set the Shadow in the checkbox, then unselect it (to toggle default shadows OFF). You should now have nicely articulated symbols of a publishable quality.

Drag the lower right corner of the outermost frame (blue?) so that the two axes are similar in length (they DO have the same scale, right?). These settings will make your graphs Biology-legible rather than Excel™-cute.

Now it is time to decide whether there is a relationship between the hand widths. Click the symbols to select the data series. Click the >Chart Layout tab. Click the Trendline button and select the Linear option in the popup. Click the Trendline button again and select the Trendline Options… choice. In the dialog box click the Options tab and then check-Display Equation and check-Display r2 value. This step produces a line through the data points representing a regression analysis, meaning that it produces a best-fit line showing the relationship between the two variables in the scatter plot. Double-click the line to be sure its color is black and 2pt weight. Be sure the regression equation values are rounded correctly (no more places than in your other calculations) and your r2 value is rounded to 3 places! The R needs to be edited to r. You need to move the equation into a clear area of the chart so it does not block the view of the data. Equal distance from top and side of the plot area is good feng sui.

The equation is shown in the y = mx + b form, where x and y are the hand widths, m is the slope of the line, and b is the y-intercept. The r2 value is a statistical representation of how well our data fit this linear regression line; correlation coefficient values above 95% (0.95) have a really excellent fit to the equation, and lower values fit less-well. You do NOT have to have a 95% value to decide there is a relationship…but it would sure be nice to be better than 50%! Direct relationships have positive slopes, inverse relationships have negative slopes, and stochastic (“unrelated” or “random”) relationships do not have linear fits (r2 < 0.05).
The relationship between these two variables is:   direct    stochastic    inverse  
Copy your final graph and paste it into a new page in your Word™ document. Check to be sure that the font is still sans-serif Arial rather than moving to serif Times or Calibri. Add a caption underneath the graph on the same page for printing. Follow the instructions for table captions, but start the caption with “Figure.” rather than “Table.” Note: this figure does not compare hand widths; it shows their relationship. So the title needs to be different too. The statistical test producing the line was linear regression not Student’s t-test!
Extending your Data Analysis:
Using your linear regression analysis equation, how wide would you
predict the right hand be for a child with a left-hand-width of 3.5 cm? ___.___ ___cm
What would you estimate would be the width of a right hand of an
amputee who has a left-hand width of 7.5 cm? ___.___ ___cm
A basketball player has a right-hand width of 12.5 cm.
How wide would you predict is his left hand? ___ ___.___ ___cm
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In making these predictions, sometimes you are finding a value that is within the range that you have measured relationship. This prediction is between your measured values so is called an interpolation. Other examples above are making predictions of values that are above or below the range of your measured relationship. Such a prediction outside your measured values is called an extrapolation.
The estimate of the child’s hand width is an   interpolation    extrapolation  
The estimate of the amputee’s hand width is an   interpolation    extrapolation  
The estimate of the basketball player’s hand width is an   interpolation    extrapolation  
Which kind of estimate is most reliable/justifiable?   interpolation    extrapolation  
Figure 2. More Comparison Figures:
Prepare a biology-legible graph showing whether body weight increases hand width disparity (because heavier people might need to use more force in their dominant hand to work with its bulk), and paste it into its own page in a Word™ document. Use what you learned above and what you find in the grading rubric for Figure 1 to guide you in preparing a proper Figure 2. In Excel™, to select the separate columns, select the data in one column, then holding down the (Mac: Apple=Command…or PC: Control key) and drag the data in the second column. Remember to avoid headers and statistical data. To properly show dependent and independent variables, you will likely need to swap the axes by selecting Charts-Data-Select and editing the formulae for x-values and y-values (exchanging just the column used: EI). Make sure your axis labels are correctly assigned after this change. Make Excel™ do a linear regression analysis showing the equation and r2 value.
Force a new page in your Word™ document. In Excel™, copy your finished graph and paste it the next line of your Word document. Remember to check for Word changing the fonts! Add a properly descriptive caption for Figure 2 underneath the graph on the same page for printing.
The relationship of body weight and hand width disparity is:   direct    stochastic    inverse  
This outcome might challenge whether our idea is just badly founded. Is there any relationship between body weight and dominant hand width?
Figure 3. 
Do heavy bodies have wider dominant hands? Prepare another figure properly showing this. The easiest way to do this is to copy the figure you just made above in Excel™ and paste it into another place on the spreadsheet. Then select Charts-Data-Select to edit the y-axis value formula to point to the dominant hand with data (EC). You will need to edit the y-axis title accordingly. After the graph updates, you will need to edit the scale of the new y-axis and delete and replace the regression equation and r2 value (it usually does not update properly).
There is a   stronger    identical    weaker   correlation between body weight and dominant hand width than there is between body weight and hand width disparity.

Force a new page in your Word™ document. Paste your graph in from Excel™ next. Then add a proper caption below Figure 3. You can copy and paste from Figure 2, but then you need to edit it!
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Figure 4. A figure with two regression analyses 
Prepare a proper graph showing the relationship between Dominant Hand Width and Body Height of male and female students in our course. In this case be sure one data series on the graph looks at male values and another data series looks at female values for dominant hand width and height. There should be two best-fit lines on this graph.

New procedures for this figure include making the graph first look at, say, the female data and formatting it all correctly. Then in Charts-Data-Select Name the first series as Female. Click the Add button to add the second series, name it Male, and then copy-paste-edit the formula from female series to the male for each axis.

Your graph should now have a new series. You can edit the symbols to bring them up to standards; perhaps having one series with open () and the other with solid () symbols is a good idea. Artistically having the “darker” symbols lower than the “lighter” symbols on the graph is better feng sui. To avoid a legend (key), you can Insert-Symbol-Advanced (from Wingding fonts) into the figure caption in Word™ where the number of female () and male () students is given. The regression lines for the “darker” symbols might be formatted as un-dashed, the regression line for the hollow symbols might also be 2pt weight but dashed to look “lighter.” Similarly the regression equation for the “darker” symbols might be bold font.

Paste your graph in from Excel™ next. Add a properly descriptive caption underneath Figure 4 on the same page.

Table 3.
From Figure 4 you hypothesize that females are   shorter    taller   than males,
and that females have   narrower    wider   dominant hands than males.
[bookmark: _GoBack]What would you like to do to statistically test your two hypotheses? In Excel, does something in Column E give you inspiration? Perform the two needed t-tests, round the data properly for the precision in your height data, and add a proper Table 3 to your Word™ file to show the results of those two tests. Perhaps Figure 2 provides you with a model? Don’t forget a proper caption.

Figure 5. Bar (Column) Charts:
The bar (aka Excel™ Column) chart is useful when one dimension of the data is categorical and the other dimension of the data is continuous. In the bean project, you had soaked and dry beans (categorical) and measured their length, weight, and volume (three continuous variables). Prepare a spreadsheet file with cell A1 blank, B1 “Length (cm)”, C1 “Weight (g)”, and D1 “Volume (mL)”. In cell A2 type “Soaked” and in cell A3 type “Dry.” Now put the corresponding averages you calculated from your Biologist at Work! worksheet into the cells of this spreadsheet. Be sure to move any decimal places needed to correctly convert to the units mentioned above. Select from A1 to D3. 

Select Insert-Charts-Column-Clustered. Enter the X-axis title as “Expansion Parameter”. Enter the Y-axis title as “Mean Measurement.”
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You need make your graph biology-legible by eliminating the Excel™-cute features as always. The colors for the column Fill should be black (for dry) and no-fill (for soaked…why? I think you can guess this easily!). The columns should not have any gradients or transparency or 3-D shadow effect, etc. All columns should have a Line Color of Black and a Line Weight of 2 pt. The key (legend) should be moved inside the plot area and should have an Arial Regular 12 pt font. Maybe the Plot Area needs to be expanded horizontally to get the variable names (units) to be on one line.

Since these are dry beans being treated by soaking, we would like the dry bars on the left and the soaked bars to appear to be overlapped behind them and toward the right. On the Mac version, Double-click (Right-Click) one set of bars and, in the dialog box, click on the Options tab. Click on the up arrow to the right of the Overlap: box a few times; this will move one set in front of the other set. You can also type in an overlap percentage value. Setting 100 percent will superimpose the columns. Set a 60% value so that it is clear that these are NOT stacked bars (with the values of the two bars adding to each other). Also observe that a negative overlap is possible to separate paired bars if that were desirable; in our case this is NOT desirable! The Order tab allows you to alter which set of columns is in the front. If your light bars are filled properly (maybe no-fill?), the desired effect is achieved.

Copy the graph and paste it into your Word™ document. Add a properly descriptive caption underneath the graph on the same page for printing. While in Word™, and typing the caption, you will wonder what to write about statistics. Clearly you did (or could do some more t-tests) and the caption should indicate that the differences shown were significantly (p < 0.05) different according to those 1-tailed, unpaired Student’s t-tests.

Assembly of your report for final submission:

Do a File-PrintPreview to see how your Word™ file looks. Verify that:
· At least one of the pages has your name on it.
· The pages should be in order.
· Each figure or table has a properly numbered, complete and formatted caption.
· Each table or chart is properly formatted to be Biology Legible!
· Each chart has a rectangular aspect ratio: approximately 2h x 3w format. (Please avoid the very popular HDTV aspect ratio: 9h x 16w format!)

Print out your Word™ file
Assemble the eight printed pages in order
Staple the sheets in the upper-left corner (no loose pages, fold-overs, or paper clips!)
Make sure the staple is close to the corner so that the inside pages can be read
Hand in your stapled output report as one document…a writing exercise.
Do not enclose your stapled report in a “report cover” of any kind.
Hand-in the writing assignment by its due date.

Verify that this worksheet is completely filled out.
Hand in this worksheet as a separate document…a laboratory worksheet…by its due date.
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